Chemistry 401 Laboratory Manual Introduction

You are responsible to read and prepare a pre-lab write-up before each week’s experiment. The items required in the pre-lab write-up are specified in the “Before Class” section of the experiment.

I. Lab notebook protocol:

- A hardbound notebook with bound pages (stitching down the middle of the book) is required.
- **Every page in the notebook should be numbered.** It is never okay to tear out pages from a lab notebook.
- **Page 1 should be retained for the**

<table>
<thead>
<tr>
<th>Exp #</th>
<th>Experiment Short Title</th>
<th>Starting Page #</th>
<th>Completeness Grade</th>
<th>Quiz Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Using Micropipets and Graduated Pipets</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Analysis of Bleach</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Thermodynamics of Salt Dissolution</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Kinetics</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>LeChatlier’s Principle</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Determination of Kc for Iron Thiocyanate</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Measurement of pH</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Buffers</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Acid-Base Titrations</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Qualitative Analysis</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Transition Metal Complexes of Ni and Cu</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Electrochemistry</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Nuclear Radiation and Geiger Counters</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Organic Chemistry Workshop</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table of Contents

Rev: 2011-2012
• This Page Intentionally Left Blank
• All data collected during lab time are to be taken in the lab notebook IN BLUE OR BLACK INK. WRITING DATA IN PENCIL WILL RESULT IN THE LOSS OF 1 POINT PER OCCURRENCE!!
• Mistakes are to be single-crossed out and initialed. It is never ok to use white-out in a laboratory notebook or to obliterate data in any way. Blank notebook pages are to have a single line drawn from one corner to the other.
• Tables must be created using a ruler. Tables that appear in the laboratory instructions may be cut-out and taped into your laboratory notebook BEFORE ENTERING DATA. Data written on laboratory instruction pages will be thrown away like any other data written on loose paper. WRITING DATA ON ANYTHING OTHER THAN YOUR BOUND NOTEBOOK WILL RESULT IN A LOSS OF 1 POINT PER OCCURRENCE!!
• Excel-plots are to be taped into the lab notebook.
• Hand-graphs may be done in pencil, but must be made with a ruler.
• After class, required graphs and calculations are to be completed by the start of the next laboratory period or as assigned by your instructor.
• If a student fills a notebook, a new one can be started with a new table of contents.
• Students will not be allowed to take data down on loose-leaf paper and then transcribe it later into their notebook.
• If a student forgets their notebook, they can obtain a second notebook from the bookstore. Not all experiments must be in the same notebook.

1. The portion of the notebook that must be filled out prior to coming to lab is included under the title: “Before Starting Experimental Work (Before Class)”
   • This section will always include writing the name and number of the experiment, the date, and leaving a space to list partners for the experiment. This will be followed by listing the purpose(s) of the experiment. It will almost always require writing a summary of each procedure to ensure that students are familiar with what will be done prior to coming to lab. Occasionally it will require drawing a picture of apparatus to be used or to list safety precautions.
   • Students are expected to have this section in their lab notebook when they arrive in class. Everything must be handwritten (with the exception of tables which may be cut out and taped in PRIOR TO DATA COLLECTION).
   • If the notebook is not formatted correctly with “before class work” written out when a student comes to lab, the instructor will likely not allow that student to do lab until it is completed. This may require them to come back to another lab section.
   • Also, the pre-lab points will not be given unless students show up on time with a properly formatted notebook

2. The remainder of the required information concerning what is to be included in the notebook is included within the body of the experimental procedures for items that are to be filled out during the completion of the experiment and under “Further Instructions”.

Typical requirements will include:
• Performing calculations associated with the experiment.
  o Calculations should be neat and legible.
  o There should be at least one good sample calculation for each type of calculations.
  o Dimensional analysis factors must be clearly shown.
  o Unrounded values should be used for follow-on calculations.
  o All final answers should be rounded to the correct number of significant figures with units attached.
  o Repetitive calculations may then be done in your calculator with the answers posted in your lab notebook.
• Creating graphs associated with the experiment.
  o Specific graphs will be required to be done either by hand or electronically in Excel or a similar piece of software.
  o Hand graphs are allowed to be done in pencil.
• Answering thought provoking discussion questions about the experiment and the theories it supports.
  o Write out the question first.
  o Answer in a complete sentence.
  o Discussion questions may be written legibly by hand in your notebook or typed up and taped into the notebook.
• Write a summary paragraph describing what was done and what was learned in the experiment, including any issues that were encountered and dealt with.
  
  **Remember, your summary should always address the purpose of the experiment!**
• If multiple experimental values were determined, they should be presented in a table including any associated accuracy and/or precision information.
  o Summary paragraphs and data tables may be written legibly by hand in your notebook or typed up and taped into the notebook.

Unless other instructions are given, the post-lab write-up must be completed by the beginning of the following lab period. It will be evaluated on a completeness basis at the time it is due.

After the experiment has been checked for completeness, you will have the opportunity to check out a key to the experiment from your laboratory instructor with which to self-check for accuracy.

Within 1-2 weeks after the completeness check, you will be quizzed on the experiment. Quizzes are open lab notebook. Taking the time to do the correctness check will greatly increase the odds of doing well on the quizzes.

### III. Attendance:

A. Laboratory attendance is required at every lab session. This is NOT a self-paced series of experiments. Each experiment is scheduled for a given day. The stockroom will bring in the required equipment and chemicals in time for the scheduled experiments. They will then be replaced by those needed to do the next experiment. **Doing an experiment on a day it is not scheduled has a big impact on our stockroom staff. It may only be done if special arrangements have been made in advance!**

B. If a student knows that they must miss a day of lab, they should make every attempt to make it up on one of the other days the experiment is offered that week. (Please check in advance to be sure that there will be room for you). In certain circumstances, you may also be able to attend another instructor’s section of lab with prior approval from that instructor. If you are absent due to illness, you must make up the lab within the time frame established by your instructor, typically no later than the following week, except in the case of severe illness or injury). You will have 1 week from the time you perform the lab to complete your write-up.

C. If a student has one missed one lab that has not been made up, the highest grade that they can receive is a “B” unless the instructor has not made a make-up session available. If a student has 2 missed labs that have not been made up, the highest grade that they can receive is a “C” unless the instructor has not made a make-up session(s) available. *(Note: Lab quizzes pertaining to missed labs that were not made-up will automatically be given zero points. Lab quizzes pertaining to labs with less than a 80% completeness score will only awarded 50% of the raw score.)* If more than 2 labs are missed and not made up, a student cannot receive a passing grade in the class. Depending on circumstances, the student will receive a “D”, “F”, or “I”.

*Rev: 2011-2012 iv*
**Experiment 1: Using Micropipettes and Graduated Pipettes (EXAMPLE PRELAB)**

Name: __________________________                                       Date:____________
Partners: _________________________

**Purpose:** The purpose of this lab is to
a) Review available types of pipettes
b) Learn how to use and check the calibration of a micropipette.
c) Learn the proper use of graduated pipettes
d) Determine the accuracy and precision of measurements taken with each.
e) Learn to pick the most accurate equipment for volume measurements.

**Summary of Procedures**

**Procedure 1: Checking the Calibration of the Micropipette.**
- Partner A should collect some DI water and record the temp to nearest 0.1 °C.
- Add 100 or 200µL of DI water to a tared weighing boat and record mass in Table 2A.
- Show results to the instructor.
- Repeat 3 more times.
- Calculate average, s.d. of mass; convert these to uL with water density, and determine accuracy (% error) and precision (% rsd) of the micropipette.
- Partner B should repeat the entire procedure at 500 or 1000 uL.
- Both partners should record the data in Table 2B.

**Procedure 2: Using the Graduated Pipette.**
- Collect some DI water and record the temp to nearest 0.1 °C.
- a) Tare balance, weigh 50 mL beaker w/ watchglass and record weight in Table 3A.
- b) Add 3.0 mL DI H₂O using the graduated pipette.
- c) Reweigh container.
- d) Subtract c – a to get weight of water pipetted.
- Show the results to your instructor.
- Repeat steps a-d 2 more times.
- Calculate average, s.d. of mass; convert these to mL with water density, and determine accuracy (% error) and precision (% rsd) of the graduated pipette.
- Partner B should repeat the entire procedure using 7.0 mL.
- Both partners should record the data in Table 3B.

**Prelab Lecture**

(This area will be blank when you come to lab. You should have a place ready to record the notes that your instructor gives you. These notes will then be available to you during any lab quizzes.)

Rev: 2011-2012
IV. Reagents and Reagent Shelves; Clean-up, and Misc.

A. Replace all reagents in the correct place on the shelf immediately after using them. Do not take reagent bottles to your workstation.

B. Do not take a larger quantity of a reagent than necessary (budgetary and disposal problems). If you need reagents at your work place, obtain them in small quantities.

C. Clean up before you leave. Have your instructor inspect your work area before you get your lab notebook signed. Your workspace and the side shelves and hood must be cleaned before your work will be initialed for the day.

D. Never pour any chemicals back into the reagent bottles! This can lead to contamination.

E. Food and/or drink are not permitted in the laboratory room.

F. Closed toe shoes are required.

G. Indirectly vented laboratory goggles are required to be worn at all times chemicals or glassware are in use in the lab.
V Check-In and Check-out Procedures

A Lab Check-In

Students check into lockers the first week of lab. Students need a breakage card before they can check-in. Check in procedures are below.

- Students will be given individual lockers. Each student must bring his/her own breakage card.

The students need to do the following to check-in:

1. a) Have a signed lab waiver form
   b) Have a signed set of safety rules and procedures
   c) Have a set of approved goggles (Form fitting to the face with indirect venting.)
2. Each student should each bring all 3 items above to the instructor’s desk with known section of the lab where you would like to have your locker assigned.
   a) Give items a & b to the instructor.
   b) Write your name on log-in sheet IN PENCIL next to any available station.
   c) Collect a small locker check-in forms and 1 large locker inventory form.
3. Fill out the small form and take it to the stockroom (roll-up window just down the hall) to obtain the combination to the lock.
4. Make sure all the items on the locker check-in sheet are in your locker and are in unbroken, unchipped and clean condition.
5. If anything is missing or broken, check with your instructor about getting a replacement from the stock room.
6. When you are satisfied that the list is complete, place a check mark in the “In” column, and return the sheet in your instructor. This sheet will be returned to you at the end of the semester. You will be asked to have all of these items in the correct quantities and clean at the end of the semester.

B Lab Check Out

1. Get locker check-in sheet from instructor or your locker.
2. Check whether all the items in the list are present in unbroken, unchipped and clean condition in your locker.
3. If anything is missing or broken, replace that item with a new one from the stockroom.
4. Clean all dirty glassware.
5. If you have anything extra, check first whether the partners you worked with are missing those items. Then, bring them to a common-pool area where people may exchange or take items they need.
6. Line your locker with new liner paper (in lab or from stockroom).
7. Place everything back in your locker and write your name on the board or call over your instructor to sign you out.
8. Upon being checked-out, take your lock and signed sheet to the stockroom and exchange it for a new lock. Return and put the new lock on locker. You’re done!
A. Accuracy: Error and Percent Error

Accuracy is the measure of how close a measurement is to a “true value” for that measurement. This is usually described by calculating the error associated with a measurement. The error in a value or measurement is the difference between the experimentally determined value and the accepted value, usually from “the literature”–a textbook or the CRC Handbook of Chemistry and Physics.

Error

The error value tells us how far away a value is from the accepted value.

\[
\text{error} = \text{experimentally determined value} - \text{accepted value}
\]

Percent Error

The percent error, often a more useful quantity, can be calculated from the error,

\[
\% \text{ error} = \frac{\text{error}}{\text{accepted value}} \times 100\%
\]

In this formula, there are no absolute value signs. The percent error can be negative!

A positive value for % error means that the experimental results were high.

A negative value for % error means that the experimental results were low.

B. Precision: Standard Deviation

Precision tells us about how much variability is present between repeated measurements of the same value. One common measurement used to rate precision is the standard deviation. For normally distributed data, approximately 67% of all measurements will fall within one standard deviation of the mean value of the measurements.

Many calculators (even my cheap one) will do standard deviations for you (if you take the time to learn how). In case yours does not (or you haven’t bothered to learn), we’ll review standard deviations. The formula for the standard deviation is:

\[
s_x = \sqrt{\frac{\sum(x_i - \bar{x})^2}{N-1}}
\]

where \(s_x\) is the standard deviation, \(x_i\) is the \(i\)th measurement of a value, \(\bar{x}\) is the average value of all measurements of \(x\), \(N\) is the number of measurements of \(x\) and \(\sum\) is the “summation” sign.

Note: If you are using your calculator to determine the standard deviation, be careful. Many calculators will calculate two different versions of the standard deviation. One is the standard deviation of a large population, which is designated as sigma, \(\sigma\) or sometimes \(\sigma_n\). Since we will almost always have small sample sets, we want to use the sample standard deviation, \(s\) or sometimes written as \(s_x\) or \(\sigma_{n-1}\).
Example

An object was weighed by 5 different students with the following results:

student 1: 44mg  
student 2: 46mg  
student 3: 39mg  
student 4: 41mg  
student 5: 48mg

What is the average mass and the standard deviation of that mass?

\[
\bar{x} = \frac{(44 + 46 + 39 + 41 + 48)}{5} = 43.6\text{mg} \quad \text{(only good to 2 significant figures, or 44mg)}
\]

\[
\sigma_x = \sqrt{\frac{(44 - 43.6)^2 + (46 - 43.6)^2 + (39 - 43.6)^2 + (41 - 43.6)^2 + (48 - 43.6)^2}{5 - 1}} = 3.6\text{mg} \quad \text{(only good to 1 significant figure, or 4mg)}
\]

This information can be summarized as: 44 ± 4mg

This tells me that 67% of the data should fall within the range (44-4)mg to (44+4)mg or 40mg-48mg.

Percent Relative Standard Deviation (%RSD)

It is often convenient to present the precision or variability of the data as a percent of the average value. (In statistics, this is also known as the coefficient of variation.)

The formula for %RSD is:

\[
\%\text{RSD} = \frac{\text{(standard deviation/average)}}{100}
\]

In the above example the %RSD = \(\frac{3.6}{43.6}\) * 100 = 8.3% ⇒ 8%

Note* Always use the un-rounded values to do further computations.

C. Q Test

In some experiments, we measure the same quantity three or more times. Occasionally, one of those measurements will be very different from the others with no obvious mistake in the procedure. The Q test is a test to see if we can assume with greater than 90% confidence\(^1\) that one point, called the “suspect value”, is in error and can be thrown out, and then the average and standard deviation can be recalculated without that point.

The Q test can best be seen in an example. Suppose that there are five measurements of absorbance:

0.223, 0.354, 0.246, 0.219, 0.231.

The average and standard deviation of this data set are 0.255 ± 0.051.

The suspect value is the one that is farthest away from the mean or average. It will always be the largest or smallest value. Of these points, the value of 0.354 is the suspect value. It is roughly two

---

\(^1\) The 90% level of confidence is one of a series of confidence levels that can be set depending on how careful you want to be.
standard deviation values away from the average value. The Q test will allow us to determine if the 0.354 value is statistically outside the normal level of variation within the data set (with 90% confidence) and can therefore be thrown out, or if we need to include it when determining the average and standard deviation (because we are not 90% confident that it’s a bad data point).

To do the Q test, we need to determine the “gap” and “range” of our data set to determine Qdata.

The gap is the absolute value of the difference between the suspect value and the numerically closest other data point.

The range is the largest minus the smallest value.

\[
gap = |0.354 - 0.246| = 0.108 \quad \text{range} = |0.354 - 0.219| = 0.135
\]

Then we can calculate Qdata:

\[
Q_{\text{data}} = \frac{\text{gap}}{\text{range}} = 0.800
\]

Qdata must then be compared to a critical value of Q in a statistics table.

If Qdata > Qcritical, then the outlier can be discarded with 90% confidence. Qcritical values are tabulated below.

<table>
<thead>
<tr>
<th>Number of Observations</th>
<th>Qcritical</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>0.94</td>
</tr>
<tr>
<td>4</td>
<td>0.76</td>
</tr>
<tr>
<td>5</td>
<td>0.64</td>
</tr>
<tr>
<td>6</td>
<td>0.56</td>
</tr>
<tr>
<td>7</td>
<td>0.51</td>
</tr>
<tr>
<td>8</td>
<td>0.47</td>
</tr>
<tr>
<td>9</td>
<td>0.44</td>
</tr>
<tr>
<td>10</td>
<td>0.41</td>
</tr>
</tbody>
</table>

For the data set in the example, there are five total observations so Qcritical = 0.64.

Since Q_{\text{data}} > Q_{\text{critical}}, the outlier can be discarded and the average and standard deviation can then be recalculated as 0.230 ± 0.010. With the outlier removed the standard deviation becomes significantly smaller, indicative that our precision has been significantly improved.
Copy for your Notebook

<table>
<thead>
<tr>
<th>Number of Observations</th>
<th>$Q_{\text{critical}}$</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>0.94</td>
</tr>
<tr>
<td>4</td>
<td>0.76</td>
</tr>
<tr>
<td>5</td>
<td>0.64</td>
</tr>
<tr>
<td>6</td>
<td>0.56</td>
</tr>
<tr>
<td>7</td>
<td>0.51</td>
</tr>
<tr>
<td>8</td>
<td>0.47</td>
</tr>
<tr>
<td>9</td>
<td>0.44</td>
</tr>
<tr>
<td>10</td>
<td>0.41</td>
</tr>
</tbody>
</table>
Chemistry 401 Laboratory
Graphing Guidelines
(for both manual and electronic graphs)

1. All graphs must have a title that clearly states what is being graphed and any constraints that would cause the graph to look different.
2. All axes must be labeled with the variable that is being plotted with the units that are being used for plotting.
3. All plotted data for a given parameter must be plotted using the same symbol. Different parameters should have different symbols.
4. All symbols must be clearly defined.
5. For hand drawn graphs, the graph paper should have enough resolution to clearly establish the position of every data point. The graph should take up most of the page, while making sure that each square on the graph paper is worth a nice round amount.

For electronically prepared graphs, sufficient gridlines should be placed both vertically and horizontally so that the graph can be easily read for the interpretation of results (e.g., unknown concentrations, points of maximum absorbance, titration endpoints, etc.)

6. All lines should be drawn with a ruler, not hand drawn. Data plot lines should be smoothed, not drawn "dot-to-dot".
7. For linear plots, the total distance between all points and the line should be minimized. This means that some points will be above and some below the line.
8. The name of the experiment, the students name, and the date should also appear somewhere on the graph.

ELECTRONIC GRAPHING USING EXCEL (XP OR 2003)

Open Excel. This can be done using by clicking on the desktop icon for Excel if one exists or by going to the start button in the lower left corner of the desktop and then looking in programs subfolder.

- First prepare the data to be plotted in columns.

Enter the information for the variable to be plotted on the x-axis in the first column of your spreadsheet. In the second column, enter the matching information variable to be plotted on the Y axis.

- Create a Draft Graph

Highlight the two columns of data that include the paired x and y values and click on the chart wizard in the toolbar at the top of the page. (This button looks like a bar chart or like some books on a shelf.)

For chart type pick scatter, and for sub type, pick the one that shows data points not connected by any lines; then click next. By pre-highlighting the data we wanted to plot before selecting the chart wizard, the correct data range and series has already been filled in. Click next to skip to the next step.

Fill in the proper Chart Title as well and the name and units of the variables being plotted on the x and y-axis. (The x-axis is along the bottom.) Click on the gridlines tab and add major and minor gridlines as necessary.

When you click the next button, you will be asked whether you want to add the graph to the existing data page or to a new worksheet. If you are working with a small amount of data, you might want to show the
data and the graph on the same page. If you are working with a lot of data, you might want to put the graph on its own separate page.

**Polish the Draft Graph.**

When you click finish, you have a working draft of your graph. You may need to edit things like the axis minimum and maximum values. To do this, double click on the feature of the graph that you want to edit.

Format the axis: **For the axis, when you double click on the axis you want to edit, it will allow you to change the scale, the fonts, etc. Click on the appropriate tab and make the change.**

**Change the background:** To get rid of the gray on the chart background to make it easier to color, right-click anywhere on the graph between the gridlines. (You should get a small dialog box that says “plot area” before you double click. If you cannot get this dialog box, you may have to make your graph bigger by clicking and dragging the square in the corner of the graph.) Select format plot area from the secondary dialog box. On the right hand side under area, select none for fill effects.

**Titles and Axis Labels:** Be sure that there is an adequate title and that all axes include the name of the variable being plotted and the units. (This may have been done well during the draft, but you can “fix” any problems at this stage.) Click on the title or label that you want to alter and a box will appear around the item.

- If you click again inside the box and you can alter the text.
- If you click anywhere on the gray edge of the box and hold down the left mouse button, you can reposition the box.
- If you go to one of the little black squares on the edge or corner of the box, wait for a double sided arrow to show and then hold down the left mouse button, you can resize the box.

**Add Regression Line:**

Once the basic chart is complete, the "Best fit line" can be added by selecting chart/add trendline from the menu bar.

- From the type tab, select linear unless you know your data is non-linear.
- From the options tab
  - Set the intercept = 0 if you know your data goes through the origin. Otherwise leave this unchecked.
  - Display the equation on the chart if the equation is needed for interpretive purposes.
  - Display the equation and R-squared on the chart if you want to know how good the correlation is between the two data sets is. (The closer the value is to 1.000, the better the correlation.).
- Select the text box that appears on the chart that contains the equation and R-squared value and drag it to a place on the graph that makes it easy to read.

**Add Name, Date, Section, etc.:** Additional information may be added to a graph through the use of a textbox. The textbox tool is found on the drawing toolbar. (If this toolbar is not currently displayed, go to menu bar and select view/toolbars/drawing.)

The textbox tool icon looks like this Click on the icon and a cross-hair will appear when you move the mouse over the graph. Click and drag to create a box to type in.
ELECTRONIC GRAPHING USING EXCEL (2007-2010)

Open Excel. This can be done by clicking on the desktop icon for Excel if one exists or by going to the Microsoft Icon in the lower left corner of the desktop and then typing Excel into the search box.

- First prepare the data to be plotted in columns.
  Start by entering the numeric data for the chart on a worksheet. Be sure that the values that you wish to appear on the x-axis are in the left column and those for the y-axis are in the right column.

- Create a Draft Graph
  Highlight the two columns of data that include the paired x and y values. You can then plot that data into a chart by selecting the chart type that you want to use on the Office Fluent Ribbon (Insert tab, Charts group). Click on the “Scatter” chart type and select the “Scatter with only markers” subtype to display your values on an x-y coordinate graph.

- Add a Chart Title
  1. Click the chart to which you want to add a title.
     This displays the Chart Tools, adding the Design, Layout, and Format tabs.
  2. On the Layout tab, in the Labels group, click Chart Title.
  3. Click Centered Overlay Title or Above Chart.
  4. In the Chart Title text box that appears in the chart, type the text that you want.
  5. To format the text, select it, and then click the formatting options that you want on the Mini toolbar.

  **TIP** You can also use the formatting buttons on the Ribbon (Home tab, Font group). To format the whole title, you can right-click it, click Format Chart Title, and then select the formatting options that you want.

- Add Axis Titles
  1. Click the chart to which you want to add axis titles.
     This displays the Chart Tools, adding the Design, Layout, and Format tabs.
  2. On the Layout tab, in the Labels group, click Axis Titles.
  3. Do any of the following:
     - To add a title to a primary horizontal (category) axis, click Primary Horizontal Axis Title, and then click the option that you want.
     - To add a title to primary vertical (value) axis, click Primary Vertical Axis Title, and then click the option that you want.
  4. In the Axis Title text box that appears in the chart, type the text that you want.
  5. To format the text, see “Add a Chart title.

- Remove Legend
  Excel will automatically add a legend (Usually “series 1”) to the right of the graph. If only one data series is being plotted, a legend is unnecessary and takes up valuable space.
  1. Click on the legend inside the chart and press the delete key.

- Chart Location
  When Excel first creates the graph, it will be placed on the same tab as the data itself. To work on the graph to get it ready to print, it is usually better to move it to its own tab to view it full scale.

- Add a Chart Title
  1. Click the chart border.
This displays the Chart Tools, adding the Design, Layout, and Format tabs.

2. On the **Design** tab, click the **Move Chart Location** icon at the end of the ribbon. This will bring up a dialog box.

3. Select **New sheet** (you can give the sheet a new name or accept the default name) and click OK.

- **Polish the Draft Graph.**
  You may need to edit things like the axis minimum and maximum values, add gridlines, or add a best-fit line (trendline) to your graph. To do this, double click on the feature of the graph that you want to edit.

**Format the Axis:**
1. **Right click** on the values for the axis and select **Format Axis**
2. **OR** Click anywhere inside the chart. On the **Layout** tab, select the **Axes** icon. From the submenu select the axis you wish to edit and then select **More Primary (Horizontal/Vertical) Axis Options** from the bottom of the list.
   - Set the minimum and maximum values to make your data fill the page, eliminating unwanted empty space on the chart. (Try to pick nice round numbers that are easily divided into smaller increments.)
   - Set the size of the major and minor units. These will determine the spacing of any gridlines that you add to your graph.
   - You can make any other modifications that you wish to the axis that you wish at this time using the available options shown.
   - (Note: You can repeat the entire process to get to the options for the other axis, or simply click on the other set of axis values while the dialog box is open.)

**Change the background:** To get rid of any color on the chart background to conserve printer ink, right-click anywhere on the graph between the gridlines. Select format plot area from the dialog box. Select No fill.

**Add Gridlines:** Be sure that are sufficient gridlines to make it easy to read and interpret your graph.
- **Right click** on the values for the axis and select **Add major gridlines or Add Minor Gridlines** as desired. If the spacing of the lines is too large or too small, go back to **Format the Axis** and change the size of the major and/or minor units.

**Add Regression Line:**
Once the basic chart is complete, the "Best fit line" can be added by selecting chart/add trendline from the menu bar.
- Click anywhere inside the chart. On the **Layout** tab, select the **Trendline** icon. From the submenu select the axis you wish to edit and then select **More Trendline Options**.
- Select linear unless you know your data is non-linear
- Set the intercept = 0 if you know your data goes through the origin. Otherwise leave this unchecked.
- Display the equation on the chart if the equation is needed for interpretive purposes.
- Display R-squared on the chart if you want to know how good the correlation is between the two data sets is. (The closer the value is to 1.000, the better the correlation.)
- Select the text box that appears on the chart that contains the equation and R-squared value and drag it to a place on the graph that makes it easy to read.

**Add Name, Date, Section, etc.:** Additional information may be added to a graph through the use of a textbox.
- Click anywhere inside the chart. On the **Layout** tab, select the **Textbox** icon. A cross-hair will appear when you move the mouse over the graph. Click and drag to create a box to type in.